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Before you install 

No nonsense license agreement 
This is a legal agreement between you and SecureWave SA covering use of the 

application known as Sanctuary Device Scanner. 

Be sure to read the following agreement before using the software. IF YOU DO NOT 

AGREE WITH THE TERMS OF THIS AGREEMENT, DO NOT USE THE SOFTWARE AND DESTROY 

ALL COPIES OF IT IN YOU CONTROL. 

This User License Agreement ("Agreement") is a legal agreement between you 

(either an individual or a single entity) and SecureWave SA ("Company"). By 

installing, copying, or otherwise using Sanctuary Device Scanner ("Software") on 

any computer or device, you agree to be bound by the terms of this Agreement.  

If you do not agree to the terms of this Agreement, you are not authorized to use 

the Software. 

TERMS OF USE 

SecureWave SA grants you a non-exclusive license to use the Software. 

The Software tool is given FREE for unlimited use. You are free to copy it onto as 

many machines as you like and make as many copies as you need for your 

personal use. 

This SecureWave product is provided to you free of charge and on an "as is" basis 

with no warranty on any kind or upgrades. 

THERE IS NO WARRANTY OF ANY KIND EITHER EXPRESS OR IMPLIED. ALL WARRANTIES ARE 

EXPRESSLY DISCLAIMED INCLUDING, BUT NOT LIMITED TO, ANY WARRANTIES OF TITLE, 

MERCHANTABILITY, FITNESS FOR PARTICULAR PURPOSE, NON-INFRINGEMENT OR ARISING 

OUT OF A PARTICULAR COURSE OF DEALING. USE THIS SOFTWARE AT YOUR OWN RISK. IN 

NO EVENT SHALL ANY LICENSOR BE LIABLE FOR ANY CLAIM, DAMAGES, OR OTHER 

LIABILITY, WHETHER IN AN ACTION OF CONTRACT, TORT OR OTHERWISE, RELATING TO, 

ARISING FROM OR IN CONNECTION WITH THIS SOFTWARE OR ANY USE OF IT. 

TITLE 

Title, ownership rights, and intellectual property rights in Software shall remain 

with SecureWave SA. International copyright laws and treaties protect this 

Software. 
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TERMINATION 

The license will terminate automatically if you fail to comply with the limitations 
described herein. On termination, you must destroy all copies of the Software and 

the Documentation on your control. 
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Overview 
Device Scanner Tool is a search product that identifies devices connected to a 

specific computer(s) or domain. It is used as a pre-installation check up — 

identifying and prospecting the use and presence of all type of devices. 

 

Notational conventions 
The following symbols are used throughout this guide to emphasize important 

points about the information you are reading: 

 Special note. This symbol indicates further information about the 

topic you are working on. These may relate to other parts of the 
system or points that need particular attention. 

 Time. Used in a paragraph describing a ‘short-cut’ or tip that 

may save you time. 

 Caution. This symbol means that proceeding with a course of 

action may result in a risk, e.g. loss of data or potential 
problems with the operation of your system. 

Typographic conventions 
The following typefaces are used throughout this guide: 

This typeface (italic) is used to represent fields, menu commands, and cross-

references 

This typeface (fixed width) is used to represent messages or commands typed at 

a command prompt 

This typeface (SMALL CAPS) is used to represent buttons you click 

Keyboard conventions 
A plus sign between two keyboard keys means that you must press those keys at 

the same time. For example, ALT+R means that you hold down the ALT key while 

you press R. 
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A comma between two or more keys signifies that you must press each of them 

consecutively. For example ‘Alt,R,U’ means that you press each key in sequence. 

To contact us 
If you have a question that is not answered in the online help, documentation, or 

the SecureWave knowledge base, you can contact your SecureWave customer 

support team by telephone, fax, email, or regular mail. 

Technical Support hours are Monday to Friday, 8:00 to 20:00 CET/CEST in Europe 

and 8:00 AM to 8:00 PM ET/EDT in USA.  

 

You can contact our technical support team by calling: 

 

+352 265 364 300 (International), 

1-877-713-8600 (US Toll Free), 

0-800-012-1869 (UK Toll Free) 

 

or by sending an email to: support@SecureWave.com 

Alternatively, you can write to customer support at: 

SecureWave Support 

Atrium Business Park 

23-ZA Bourmicht 

L-8070 Bertrange 

Luxembourg 

mailto:support@SecureWave.com?subject=Technical%20support" 
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Installation 
The installation process is direct and simple. To install the program: 

1. Search for the included setup_devscan2.exe file and double click on it. 

This will execute the program displaying the first screen: 

 

Figure 1: Installation: welcome dialog 

2. Click on NEXT to proceed with the installation. You now need to accept 

the license agreement before proceeding. Read the terms and click on I 

accept the license agreement and then on Next to continue. 

 

Figure 2: Installation: license agreement 
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3. In this next step, you define the installation folder. Click on BROWSE to 

change it. 

 

Figure 3: Installation: installation folder 

4. The next window starts the installation procedure. Click on NEXT to 

continue. 

 

Figure 4: Installation: starting the installation procedure 
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Figure 5: Installation: ending the installation 

5. When the installation procedure has finished, the following screen is 

displayed. Click on “Finish” to exit the installation wizard. 

 

Figure 6: Installation: completing  the installation 

6. You can now proceed to Start  Programs  Sanctuary  Device 
Scanner  Device Scanner Console to execute the tool. The other 

available options are described in The Sensor service on page 33. 

 

Figure 6: Installation: Start menu shortcuts 
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Uninstalling Sanctuary Device Scanner 
At any time after installing Sanctuary Device Scanner, you can uninstall it from 

your computer. Select Add/Remove Programs from the Windows Control Panel, and 

choose Sanctuary Device Scanner from the list of installed programs. The Setup 

program launches and uninstalls Sanctuary Device Scanner from your computer. 

You do not need to reboot the computer once finished. 
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Finding your way around 
This chapter describes the different programs elements and how you can use them 

effectively. 

Starting up Sanctuary Device Scanner 
Once the program has been installed — see Installation on page 7 — you can 

proceed to Start  Programs  Sanctuary  Device Scanner  Device Scanner 
Console to start the program. You can also create a shortcut in Windows’ desktop 

for your convenience. 

The program main window 
Once started, you see the Sanctuary Device Scanner window that has a standard 

Microsoft interface, which is easy to use and is one that most users are familiar 

with. 

The following illustration identifies the various areas of the screen.  

 

Figure 7: Program’s window 

The Menu bar in the upper part of the window lets you choose different functions 

and commands available. As with nearly all Windows’ programs, you can use the 
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ALT key to have immediate access to the different commands. You can use, for 

example, ALT+TR to get refresh the main window. 

The Control Panel lets you select among the several program modules: 

> Scans- to see your different scan results 

> Reports- to get a range of useful XML formatted reports 

> Configuration- to change program’s options 

> Scan Ranges- to define computer(s), IP address ranges, or domain to scan  

The Toolbar gives you immediate access to the tools otherwise provided by the 

Tools item located on the menu bar. 

The Main Window changes depending on the control panel chosen module. It is 

context specific. 

On the Status bar you can follow a scan progress or be informed about what the 

program is doing in each module. 

You can use the Immediate Scan bar you can define a host, user name and 
password to do an immediate scan (by clicking on the icon located to the right) 

The program menus 
In the upper part of the window, you have the menu bar. In this bar, you can find 

the following items: 

Menu Used to … 

File  
> Export actual scan with default name (XML format) 
> Exit the program 

Tools  
> Start a scan (search for connected devices). 

> Start or stop a scheduled scan. 
> Refresh the main window 

Help  
> Access this help file. 
> See program info. 

Table 1: The three available menus in Sanctuary Device Scanner 

You will find a brief description in the next sections. 

The File menu 

Use the File menu to save the list of known devices in XML format or to close the 

program. 
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You can choose between the following items: 

Menu Description 

Export to XML Allows you to save the actual scan in a XML format file. 

Exit Quit the Sanctuary Device Scanner program. 
Table 2: The File menu items 

The Tools menu 

Use the Tools menu to start a scan, start or stop the scan scheduler, or refresh the 

main window screen. 

You can choose between the following items: 

Menu Description 

Scan now You can start a new device scan. The filters defined in the 

Scan Ranges and Configuration windows are applied. 

Start Schedule Start the scan scheduler. The filters and options defined in 

the Scan Ranges and Configuration windows are applied. 

Stop Schedule Stop the scan scheduler. 

Refresh Update the main window screen. 
Table 3: The Tools menu items 

The Help menu 

This menu, Help, is primarily used to access the help file menu. It also gives you 

information about the program’s version and access to SecureWave’s Web site: 

Menu Description 

About This item displays information about the current version of 

Sanctuary Device Scanner. 

Help Contents This command allows you to view the help file. 

SecureWave on 
the Web 

You can go to the SecureWave home page from here. There 

you can find updated information about Sanctuary Device 

Control and all our other products. 
Table 4: The Help menu items 
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The Control Panel modules 
Grouped on the control panel you will find the following modules: 

Scans 

When double clicking this option, a list of all computers and devices scanned is 

shown: 

 

Figure 8: Example of a scan 

No options can be changed here but you can use the Immediate Scan Bar to do a 

scan defining the required parameters (host, user’s name and password). Device 

attributes are displayed only for information purposes. However, you can change 

the scan parameters using the Configuration or Scan Ranges modules. If you are 

on the first level of this module (Scans), you can trace the scan progress using the 

log panel: 

 

Figure 9: Scan trace in the Log panel 
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Reports 

Use the Reports module to get the actual scan devices information classified 
according to several criteria. 

You can choose between the following items: 

Menu Description 

Device list Use this command to obtain a report showing a complete 

device list. 

Devices by host Use this command to get a report ordered by host name. 

Devices by class This item lets you select a report classified by device class. 

Devices by bus Using this command, you can see a device list classified by 

bus type. 
Table 5: The Reports menu items 

On the upper part of the screen you can see a list of all previously generated 

reports (if available). You can right click on a register to select between Viewing or 

Deleting the report. 

Configuration 

Use this module to define several program parameters: 

> Add, edit, or remove filtered classes 

> Define the scan interval (schedule) 

> Define the communication port 

> Chose the # of threads 

> Select the scan timeout 

> Opt to do a scan with the network user in case of the machine refusing the 

actual user’s credentials. 

Scan ranges 

You can control the way scan are done in this module. You can perform scans by: 

> Computer name 

> IP address 

> Entire Active Directory Domain 
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Making an initial device scan 
Your first task when using the program — unless you have previously done one — 

is to define the scan range (computer(s), IP address, or domain to scan). Once this 

done, you have several elements to play with: 

> A complete HTML report 

> Computer and device info 

> A raw XML device list 

The procedure will be: 

1. Configure the program using the Configuration module defining all 

required parameters 

2. Define a scan filter using the Scan Ranges module 

3. Scan your selected range using the scan module 

4. Optionally, save your scan info as a XML file 

5. Generate the required reports 

We analyze each module in detail in the following sections. 

 You cannot scan machines that hide behind a firewall. 

 You cannot revert to the default settings if you modify them (in 

the Global Configuration window). Use the following table if you 
want to go back to the original configuration. 
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Setting Default value 

Scan interval 60 minutes 

Scan threads 5 

Communication port 7439 

Scan timeout 60 sec. 

Scan on connection 

failure 

Not activated 

Filtered classes 1394.*; 1394Debug.*; 61883.*; Battery.*; Bluetooth.*; 
Computer.*; Display.*; Dot4.*; Enum1394.*; fdc.*; hdc.*; 

HIDClass.*; ISDD.*; Keyboard.*; LegacyDriver.*; MEDIA.*; 
MdiaChanger.*; Monitor.*; Mouse.*; Mice and other.*; Net.*; 

NtApm.*; Player_Recovery_Device.*; Processor.*; RamDisk.*; 
SBP2.*; SCSIAdapter.*; SDHost.*; System Device.*; Unknown.*; 

USB.*; Volume.*; VolumeSnapshot.*; VSO Devices.*; WCEUSBS.* 

Table 6: Default configuration 
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The Scans module 
When generating a scan, you can see the results in the Scans module main 

window: 

 

Figure 10: An example of the scan panel 

Once a scan is generated — either by a new scan or by scheduling it —, you can 

proceed to get a report using the corresponding module. See Reports on page 23 

for more information. 

 If you scan the same computer(s) several times, you may get 

duplicated registers in the tree view. Refresh (ToolsRefresh) 
the screen each time to get the updated view. 

Scan parameters & details 
The program generates a detailed device description (unless otherwise defined by 

the parameters and options of the Filtered Classes of the Configuration module) 

when doing a scan. All parameters controlling the scan results are defined on The 
Configuration module (page 27) or The Scan Ranges module (page 29). 
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Figure 11: A device info example 

If you select any of the removable storage devices you get, beside very detailed 

info, the device serial number of all specific devices of this particular type that 

have been connected to the selected range. 

Starting a scan 
You can start a new scan at any moment by using the options provided on the 

Tools menu or by right clicking on the Scans module: 

 

Figure 12: The Tools menu 

Using this menu, you can: 

> Start a scan 

> Start or stop the scheduler (does not work in interactive mode) 

> Update the main window 

You can also do an immediate scan filling in the host, user’s name, and password. 
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Log panel 
If you are on the first level of this module (Scans), you can trace the scan progress 

using the log panel located on the lower part of the main window: 

 

Figure 13: Scan trace in the Log panel 

Immediate scan 
Use the Immediate Scan Bar to initiate a scan. To begin a scan, type in the host, 

user’s name, and password and then click on the “Scan” icon located on the right 

part of this bar.
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Reports 
The Reports menu allows you to generate a variety of reports about device 

information including device name & class, bus type and host. The generated 

reports are HTML files that can be viewed using Internet Explorer or any other Web 

browser defined on your system. The reports can be printed, copied, converted, 

saved, and modified as required. Reports are created in the Report folder located 

in your Program Files\SecureWave\Sanctuary\DevScan\reports (unless otherwise 
specified on the installation). 

 Once the output is shown in your favorite Web browser, you can use 
the ‘Print’ options to keep a hard copy backup of your report. Consult 
your browser help for details. 

 You can change the way the date is formatted using the ‘Regional and 
Language’ options of the ‘Control Panel’ of your Windows system. 
Consult Windows Help for details. 

 Reports are created using the respective template found in the 
<appinstall>\templates directory. 

Reports are automatically saved — in the default \reports directory — and can be 

printed for your future reference. 

The following table summarizes the types of reports that can be obtained when 

doing a scan or by loading a previous one: 

Type of Report Description 

Device list Use this command to obtain a report showing a complete device 

list. 

Devices by 
host 

Use this command to get a report order by host name. 

Devices by 
class 

This item lets you select a report classified by device class. 

Devices by bus Using this command, you can see a device list classified by bus 

type. 
Table 7: Types of reports that can be obtained by a user 
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Generating a new report 
You need to first generate a scan in order to create a valid (non empty) report. See 

Making an initial device scan on page 17 and The Scans module on page 19 

To create a new report 

1. Select Reports from the Control Panel. The following screen is displayed: 

 

Figure 14: Creating a new device scan report 

2. Select from the list the type of report you will like. Once you are ready 

to proceed, click on GENERATE. The report generation routine begins. 

3. The program generates a final Device List (as an example) HTML report. 

This page is opened in your default Web browser: 
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Figure 15: Device list report 

The report is also saved in the <appinstall>\reports\ folder. You can 

print it for future reference. 

Saving a report 
All generated reports are automatically saved in the <appinstall>\reports\ folder 

and shown in the Reports section of the module’s main window. No user action is 

needed except for maintenance (deleting, viewing, or printing). 

Viewing old reports 
Every report is automatically saved in the <appinstall>\reports and can be located 

using Window’s File Explorer if needed. The program also shows the list in the 

Reports section of the module’s main window from where you can view them 

directly. 

To view a report: 

1. Select the register from the Reports list. 

2. Right click on the register, double click on it, or press Enter to directly 

open the report in your predefine Internet browser. If right clicking on 

the register, select View Report from the popup menu. 
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Deleting old reports 
Reports are never deleted and it is your responsibility to do so. To erase old 

reports: 

1. Select the register from the Reports list. 

2. Press Delete or right click on the register. If right clicking on the 

register, select Delete Report from the popup menu. 

3. Click YES on the confirmation dialog. 

Printing a report 
Reports are printed using your predefined Internet browser. To print a report, you 

must first open it and then select File  Print or Ctrl+P (if using Windows Internet 

Explorer). 
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The Configuration module 
This module is used, in conjunction with the Scans Ranges module, to configure 

some of the scans global options. 

 

Figure 16: The Configuration module 

Filtered classes 
The upper part of this module’s main screen shows a list of all classes that will be 

excluded from the scan even though they are, in essence, devices by their own. 

Examples of this are the video cards. As these cannot or may not be controlled 

using Sanctuary Device Control, there is no need to scan them. You can add, 

delete, or edit a filter by right clicking on the Filtered Classes panel: 

To add a filter 

Right click on the Filtered Class panel and select Add Filter from the popup menu. 

Proceed to define the filter using a regular expression. It can be as simple as a 

wildcard character (Displ.*) or as complex as you need (ˆ[ \t]+*). Type in the filter 

in the field and click on SAVE. 
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Figure 17: Adding or modifying an exclusion filter 

To edit a filter 

Select from the list the register you want to edit and do a right click. Select Edit 
Filter from the popup menu. You will get the same dialog as for adding an 

exclusion filter. Change the field and click on SAVE. 

To remove a filter 

Select from the list the register you want to delete and do a right click. Select 

Remove Filter from the popup menu. 

Other available options 
The bottom part of the main window contains several other options related with 

the scans: 

> Scan Interval: Used for scheduling: defines the period (in minutes) between 

consecutive scans. You can restart a schedule by using the tools menu or Scans 

contextual menu. 

> Scan Threads: here you can also the number of parallel scan to be performed. 

> Communication Port: Port used by the Console to communicate with the scan 

service component. If the port number is changed, you will need to restart the 

scan service in order to make the change take effect. The scan service can be 

restarted by typing “net stop devsensor” in a DOS box, followed by a “net start 

devsensor”. 

> Scan timeout: period (in seconds) before the program gives up a 

communication and proceed with the next one in the list. 

> Scan on connection failure: usually the scan is don e using the credentials of 

the user defined in the Scan Ranges module. If this is not possible for some 

reason and this option is active, the program will try to do the scan using the 

service account which started the “DevSensor” service (usually NT 

Authority\NetworkService). 
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The Scan Ranges module 
You can define precisely what should be scanned or not using this module. 

 

Figure 18: The Scan Ranges module main window 

Adding, editing, or deleting ranges 
If you right click on any part of the Scan Ranges module main window (or on a 

register if you want to edit or delete it) you get the following popup menu: 

 

Figure 19: The Scan Ranges right click popup menu 

Select the required option to add, edit, or delete a register as specified in the 

following sections. 
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Adding a rule 
To add a new rule, follow these steps: 

1. Right click on any part of the Scan Ranges module main window. 

2. Select the type of scan: Computer, IP range, or Domain. 

Depending of the selected type you get one of the following screens: 

 

Figure 20: Scan Range for 
computers 

 

Figure 21: The Scan Range for 
IP addresses 

 

Figure 22: The Scan Range for 
a Domain 

3. If required, type in the Username and password fields. If left empty, the 

service credentials are used. 

4. Click on the SAVE button to close the dialog and keep your filter or on 
CANCEL to abandon the action. 

If defining a computer range, type in name of the computer and end it with the 

ENTER key. You can also use the ellipsis button to search for them and add them 

using an auxiliary dialog: 

 

Figure 23: Selecting computers directly from the Add Computer dialog 
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Deleting a range 
To delete a range, select it from the main window and right click on it. Select the 
Remove Range item from the popup menu. 

Editing a range 
You can edit a range by selecting it from the main window and right clicking on it 

to select the Edit Range item from the menu. Once the Scan Ranges dialog is 

opened, edit the parameters directly on each required field. 

Importing ranges 
You can directly import an IP addresses range or computer list to rapidly populate 

the scan range by clicking on the IMPORT button located on the lower right part of 

the window. You are presented with a dialog from where you can directly type the 

name of the file (including the complete path) or search for it using the ellipsis 

button. Once the file located, click on the IMPORT button to complete the process or 

on CANCEL to close the dialog without importing the file. 

 

Figure 24: Importing an IP address or computer range list to scan 

 If you import a range and do not select the proper option, the 

list would not be correctly recognized. 
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The Sensor service 
Sanctuary Device Scanner works based on a service plus a control console where 

all scans, reports, and configuration is done. 

Using Windows START button (or  key), you can directly access the service or 

console.  

 

Figure 25: The Windows’ Start menu 

You can see that there is one option to open the console while the other three 

ones are used to control the service. 

Starting and stopping the service 
There are times where you do not want the service to continue running once you 

are not using the console or the other way around. 

The last two options of the start menu are use to start and stop the sensor service. 
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Interactive sensor 
The use of the interactive mode of the sensor service is recommended for 
debugging purposes or to get a detailed scan log. 

To use the service interactively, just select it from the Start menu and type in the 

required command (scan, scanip, scanhost, hosts, devices, config, starts, exit) 

 

Figure 26: The Configuration module 

If you want to create a log, redirect the output from the command line as in the 

following example:  

C:\”Program Files”\SecureWave\Sanctuary\DevScan\sensor.exe –scan > log.txt 
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Requirements and Limitations 

In order to be able to use Sanctuary Device Scanner tool, you need to comply with 

the following requirements: 

1. The workstations to be scanned must have the Remote Registry service 

installed and running before doing a scan. 

 Remember that activating this service may allow other user to 

edit your registry remotely but can also allow the administrator 
to remotely audit the company’s client machines. 

2. The computer(s) to be scanned must be turned on and connected to the 

current domain during the scan process. 

3. Device Scanner does not work (or works partially) when installed on a 

Windows 2003 Sp1 OS. 

4. Computers behind firewalls are not scanned. 
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Glossary 
Class 

A device class is a collection of devices that have similar characteristics and that 

can be managed in a similar manner; for example, a Palm V5x device belongs to 
the Palm Device Class. 

HTML 

HyperText Markup Language is a language used for the creation of Web pages and 

other information to be displayed in a Web browser. 

Remote Registry service 

A Windows’ service that, when activated, allows a remote user to read or modify 

registries in the local computer. 

Service 

A program, working in the background, that offers certain functionalities needed 

(or not) by the operating system. 

Template 

A predefined layout used by the program to create the reports. 

XML 

The Extensible Markup Language is a general-purpose markup language capable 

of describing many different kinds of data. Its primary purpose is to facilitate the 

sharing of data across different systems 
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